Cobra™ Laser Profile Scanner

Users Guide
# Table of Contents

## About This Guide
- Organization ................................................................. i
- Who Should Read This Manual? ........................................... ii
- Related Publications ....................................................... ii
- Documentation Conventions ........................................... iii
- Special Symbols Used in This Manual ................................. iv
- Customer Service ............................................................ iv

## For Your Safety
- Laser Safety ................................................................. v
  - Laser Safety Markings .................................................. vi
  - For More Laser Safety Information .................................... vi
- Electrical Safety ............................................................ vii
  - Power and Grounding ................................................... vii
  - Servicing ..................................................................... vii
- Liquids ............................................................................ vii
- Accessories ..................................................................... viii
- Unsafe Operating Environments ....................................... viii
  - Medical ....................................................................... viii
  - Radioactive (Nuclear) ..................................................... viii
  - Explosive Atmosphere ................................................... viii

## Section 1: Introduction
- What Is Cobra? .............................................................. 1 - 1
- Components ................................................................. 1 - 2
- Specifications .............................................................. 1 - 6
- Dimensions ...................................................................... 1 - 7
- Computer Requirements ................................................ 1 - 8
Section 2: Installation and Setup

System Certification ................................................................. 2 - 1
Unpacking and Setting Up Cobra 2D ........................................ 2 - 2
   Tools and Materials Required ........................................... 2 - 2
   Unpacking Procedure ...................................................... 2 - 2
Mounting the Video Camera and LCD Screen Assemblies .............. 2 - 6
   Tools and Materials Required ........................................... 2 - 6
   Mounting Procedure ...................................................... 2 - 6
   Cable Connections ......................................................... 2 - 10
Unpacking and Setting Up Cobra 3D ......................................... 2 - 14
   Tools and Materials Required ........................................... 2 - 14
   Support Surface Requirements ......................................... 2 - 14
   Unpacking Procedure ...................................................... 2 - 15
Installing Scan-X .................................................................... 2 - 19
   Installing on Windows 2000 Systems ................................... 2 - 23
Setting the Parallel Port Address and Mode ............................... 2 - 28
Enabling Scan-X 3D Mode ...................................................... 2 - 30
Registering Scan-X ................................................................. 2 - 31

Section 3: Getting Started

Powering Up Your System ........................................................ 3 - 1
   Screen Layout (2D Mode) .................................................... 3 - 2
   Screen Layout (3D Mode) .................................................... 3 - 3
Accessing the Scan-X On-Line Help ........................................ 3 - 3
   How to View Help Topics .................................................. 3 - 4
   Help Topic Window .......................................................... 3 - 5
Raising and Lowering the Sensor ............................................. 3 - 6
How to Perform a Scan: Scanning a Penny ............................... 3 - 7
Optimizing Laser Settings ...................................................... 3 - 12
   Maximum Exposure ......................................................... 3 - 12
   Threshold ................................................................. 3 - 13
Section 4: Swapping Sensors

DRS Models ................................................................. 4 - 1
Swapping Sensors on Systems Equipped with the Video Camera Option ........................................... 4 - 2
  Removing the Video Camera Assembly and Sensor ................................................................. 4 - 2
  Mounting the Video Camera Assembly and Sensor ................................................................. 4 - 5
Swapping Sensors on Systems Not Equipped with the Video Camera Option .................................... 4 - 8
  Removing a Sensor .................................................................................................................... 4 - 8
  Mounting a Sensor ................................................................................................................... 4 - 9

Section 5: Adjusting the Sensor Mounting Pad

Rotational Alignment ...................................................................................................................... 5 - 1
Vertical Adjustment ...................................................................................................................... 5 - 4

Section 6: Troubleshooting

Appendix A: Setting the Display Properties

Reducing the Number of Displayed Colors .................................................................................... A - 2
Reducing the Hardware Acceleration ............................................................................................. A - 3

Appendix B: Focusing and Aligning the Camera

Focusing the Camera ....................................................................................................................... B - 1
Aligning the Camera to the DRS Laser Sensor ............................................................................... B - 3
This page was left blank intentionally.
About This Guide

Welcome!

Quality Vision International (QVI) has produced this Users Guide as part of its ongoing effort to provide users with useful, comprehensive documentation. This manual has been developed using documentation standards and a design that enhances readability and makes it easier to find information.

We believe this manual will assist you in the installation and operation of your Cobra Laser Profile Scanner. If you should have and questions that are beyond the scope of this manual, please contact your local authorized sales representative.

Organization

The Cobra Laser Profile Scanner Users Guide contains the following sections:

About This Guide (this section), describes the organization of this manual, outlines the documentation conventions used in this manual, and provides information regarding customer service.

For Your Safety, provides an overview of necessary safety precautions to be observed whenever using your Cobra.

Section 1, Introduction, provides an overview of Cobra and the Scan-X software, describes Cobra features and functions, lists Cobra specifications, and describes minimum computer requirements.

Section 2, Installation and Setup, provides installation instructions for your Cobra system and the Scan-X software, includes information about how to set up your computer, describes how to enable Scan-X 3D mode, and contains information about registering the Scan-X software.

Section 3, Getting Started, provides information on how to power up your Cobra system, raise and lower the sensor, perform a scan, optimize laser settings, and use the Scan-X on-line Help.
Section 4, Swapping Sensors, provides instructions on how to remove and replace sensors.

Section 5, Adjusting the Mounting Pad, describes how to rotationally and vertically adjust the sensor mounting pad.

Section 6, Troubleshooting, is brief guide to troubleshooting system problems.

Appendix A, Setting Display Properties, describes how to adjust the display properties on your system for optimum performance with Scan-X.

Appendix B, Focusing and Aligning the Camera, describes how to focus and align the video camera (if equipped) on your Cobra.

Who Should Read This Manual?

Read and familiarize yourself with this manual if you will be involved in the installation and/or operation of your Cobra.

Related Publications

In addition to this manual, QVI may provide the following documentation related to Cobra:

- *Cobra Certification Reference Guide* (P/N 790281). This manual contains instructions for verifying the measurement accuracy of your Cobra system.

- *Scan-X Reference Guide* (P/N 790338). This manual provides an in-depth description of the Scan-X software. It describes the user interface and provides instructions on how to use the numerous functions available in Scan-X.

- *AutoScan Users Guide* (P/N 790336). This manual is designed for the advanced user and describes how to use AutoScan and/or Scan-X to automate your Cobra system. It contains a pair of tutorials and includes the AutoScan Public Class References and Scan-X Public Interface References.
Documentation Conventions

To help you locate, interpret, enter or select information easily, this manual uses consistent visual cues and standard text formats. For example, capital letters (or upper-case letters) may be used to call attention to certain words and to help eliminate confusion and ambiguity. These documentation conventions are explained in the table below.

<table>
<thead>
<tr>
<th>Type Style or Symbol</th>
<th>Used for</th>
<th>Examples and Explanations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold or italic</td>
<td>• Emphasized words</td>
<td>• Do not repeat this step</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select the highest magnification level</td>
</tr>
<tr>
<td>Bold, sans-serif typeface</td>
<td>• Commands to be typed</td>
<td>• Type Exit</td>
</tr>
<tr>
<td></td>
<td>• Keys to be pressed</td>
<td>• Press the Enter key</td>
</tr>
<tr>
<td></td>
<td>• Menu items to be selected</td>
<td>• Select Profile View in the View menu</td>
</tr>
<tr>
<td>/</td>
<td>• Selections from a main menu and submenus</td>
<td>• Select File / Exit</td>
</tr>
<tr>
<td>Initial caps</td>
<td>• Proper nouns</td>
<td>• Use the Measure function</td>
</tr>
<tr>
<td></td>
<td>• Product names</td>
<td>• Scan-X; Cobra</td>
</tr>
<tr>
<td></td>
<td>• Sections, figures</td>
<td>• See Section 3</td>
</tr>
<tr>
<td>All caps</td>
<td>• Acronyms</td>
<td>• ASCII; QVI</td>
</tr>
<tr>
<td></td>
<td>• File names</td>
<td>• Edit INPUT.INI</td>
</tr>
</tbody>
</table>

About This Guide
Special Symbols Used in This Manual

Throughout this manual you will find special information set apart from the body text as Warnings, Cautions, Notes, and On-line Help references. The meaning of each is explained below.

---

**Warns you of the possibility of personal injury due to electrical shock when performing a task related to the subject matter of this manual. Follow all instructions precisely to ensure your safety.**

---

**Warns you of the possibility of other personal injury when performing a task related to the subject matter of this manual. Follow all instructions precisely to ensure your safety.**

---

**Alerts you to the potential for damage to the components of Cobra. Special instructions may be included for minimizing this risk.**

---

**Note:** Provides additional information related to the topic being discussed.

---

**On-line Help:** Provides references to Scan-X on-line Help topics that include additional information about the topic being discussed.

---

Customer Service

QVI values all its customers. Please contact your local authorized sales representative for:

- Customer service
- Questions and comments
- Information about additional training or support for your application

Please have your Cobra serial number and the Scan-X software version number ready when you contact us.

**Note:** For more information regarding Scan-X, see the *Scan-X Reference Guide* (P/N 790338) and/or the *Scan-X On-line Help*.
For Your Safety

For your personal safety, please review the following safety precautions. They are provided for your protection, and to prevent damage to your Cobra. This safety information applies to anyone who comes in contact with Cobra.

**Laser Safety**

---

Read the laser safety information carefully and follow all safety precautions. Not following safety precautions could result in hazardous radiation exposure to your eyes.

---

Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.

---

Cobra should never be tilted or turned over while the laser LED is lit.

Cobra Digital Range Sensors (DRS) use a laser diode as the laser source. DRS laser energy is not dangerous to exposed skin. However, if viewed directly or from a reflection of a specular (mirror-like) surface for a period of time longer than the normal human aversion to bright light, the emitted light from those sources may be harmful to the human eye.


Cobra DRS laser sensors meet Class II requirements of the CFR 21 standard and Class 2 requirements of the IEC-825 European standard.
Laser Safety Markings

The following laser safety labels are attached to the laser sensor, and indicate Cobra’s compliance with CDRH and IEC-825 regulations.

<table>
<thead>
<tr>
<th>Safety Label</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="International Laser Symbol" /></td>
<td>International Laser Symbol</td>
</tr>
<tr>
<td><img src="image" alt="IEC-825 Laser Safety Classification" /></td>
<td>IEC-825 Laser Safety Classification</td>
</tr>
<tr>
<td><img src="image" alt="CAUTION" /></td>
<td>CDRH Laser Safety Classification</td>
</tr>
<tr>
<td><img src="image" alt="Avoid Exposure" /></td>
<td>Laser Aperture Warning</td>
</tr>
</tbody>
</table>

For More Laser Safety Information

For more information on laser safety, contact the Laser Institute of America (lia@laserinstitute.org) and ask for ANSI specification number Z136.1-1993. The Laser Institute of America also offers other booklets and information on laser safety.
Electrical Safety

The Cobra DRS control module and sensor operate at low voltages and power levels. However, observe the following precautions regarding electrical safety.

Power and Grounding

Your Cobra is grounded through the power cord. To avoid electric shock, plug the power cord into a properly wired receptacle with an earth ground connection.

A protective ground connection is essential for safe operation of your Cobra.

Power Cord

Follow these general safety rules regarding your Cobra’s power cord:

- Use only the power cord and connector supplied with your Cobra. If you must use an extension cord, make sure it is grounded and is of the proper type and wire gage.
- Do not operate your Cobra if the power cord is damaged.
- Position the power cord so that it will not be tripped over, pulled, or come in contact with a hot surface.

Servicing

Cobra servicing should only be performed by qualified personnel.

Do not remove Cobra’s bottom panel to expose internal components. This is a high voltage area that should only be accessed by an authorized service representative. Contact your authorized service or sales representative for assistance.

Liquids

Keep water and other liquids away from your Cobra, to reduce the risk of spillage and electrical shock.
Accessories

Do not use any accessory attachments other than those provided or approved by QVI. Improper accessories can cause fire, electric shock, and/or personal injury.

Unsafe Operating Environments

Do not operate your Cobra in the following environments, where specific regulatory compliances are required.

Medical

Do not operate your Cobra in hospitals, clinics, or laboratories, where sensitive patient monitoring equipment may be affected.

Radioactive (Nuclear)

Your Cobra’s electronics are not radiation-hardened. Do not operate your machine in a radioactive environment.

Explosive Atmosphere

Do not operate your Cobra in environments where flammable gases and vapors or explosive dust are present. These could be ignited by the heat or sparks which may be generated by your Cobra system.
Section 1

Introduction

This section includes an overview of Cobra, shows the components for each
configuration and describes their respective functions, lists specifications, and
outlines the minimum computer requirements for customers supplying their own
computer.

What Is Cobra?

The Cobra 2D and Cobra 3D Laser Profile Scanners are economical,
non-contact measurement systems ideal for quickly scanning any part or surface
to produce high-resolution, two-dimensional or three-dimensional profiles.
Cobra combines laser technology, a computer-controlled moving sensor, and the
Scan-X data analysis software to produce an extremely versatile profile scanner.
Since Cobra scans by moving the sensor itself over the part; no special fixturing
is required.

Non-contact laser scanning is ideal for the non-destructive measurement of
fragile or pliable parts. Cobra is particularly useful for measuring precision cast,
machined, and stamped metal parts, toolings and dies, molded plastic
components, printed inks and paper surfaces, milled surfaces, membranes, and
coatings. It is also excellent for measuring flex circuits, epoxy dots, thick film,
and solder paste.

Cobra 2D can be used on a benchtop, mounted in your own fixture, installed
in-line to take process measurements, or placed directly over a larger
component. Parts are positioned below the sensor and are scanned by moving
the sensor along the Y axis. This creates a profile of the part surface.

Cobra 3D extends Cobra 2D functionality through the addition of computer
driven X axis staging. Parts are positioned on the stage and are scanned by
moving the sensor along the Y axis and the part along the X axis. This creates
numerous parallel linear profiles and generates a three-dimensional image.

Cobra is available with a video camera option for real-time imaging of the part
under test, which simplifies setup and specific feature selection for improved
throughput. The video camera option is only available on Cobras equipped with
DRS-300 or DRS-500 laser sensors.

Computer to run Scan-X and operate Cobra is required. A Pentium class
computer is available if you choose not to supply your own.
Figure 1-1 shows the various components of Cobra 2D. See the table that starts on page 1-4 for information about the component functions.
Figure 1-2 shows the various components of Cobra 3D. See the table that starts on page 1-4 for information about the component functions.
If your Cobra system is equipped with the video camera option, it has the additional components shown in Figure 1-3. See the table below for information about component functions.

![Cobra Equipped with Video Camera Option](image)

**Figure 1-3. Cobra Equipped with Video Camera Option**

This table describes the functions of the various Cobra components.

<table>
<thead>
<tr>
<th>Component</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus Knob</td>
<td>Raises and lowers the sensor to focus the laser over the part surface</td>
</tr>
<tr>
<td>Locking Knob</td>
<td>Locks the Z axis slide in position</td>
</tr>
<tr>
<td>Sensor Mounting Pad</td>
<td>Supports the sensor on the end of the stage arm</td>
</tr>
<tr>
<td>Thumb Wheel</td>
<td>Raises and lowers the back of the main unit to level Cobra by adjusting the sensor’s angle of travel (not used on 3D systems)</td>
</tr>
<tr>
<td>Parallel Port</td>
<td>Connects Cobra via parallel cable to the parallel port on the associated computer, providing communication between the computer and Cobra</td>
</tr>
<tr>
<td>Power Switch</td>
<td>Controls power to the main unit (I = on, O = off)</td>
</tr>
<tr>
<td>Component</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Power Cord Receptacle</td>
<td>Connects Cobra via power cord to main power source</td>
</tr>
<tr>
<td>System LED</td>
<td>Indicates Cobra system power is on – illuminates when Cobra is turned on</td>
</tr>
<tr>
<td>Motor Cable</td>
<td>Provides power to the X axis motor (3D systems only)</td>
</tr>
<tr>
<td>X Axis Stage</td>
<td>Provides third axis of measurement (3D systems only)</td>
</tr>
<tr>
<td>Granite Base</td>
<td>Provides a study work surface for optimum performance (3D systems only)</td>
</tr>
<tr>
<td>Sensor</td>
<td>Takes laser-based height measurements</td>
</tr>
<tr>
<td>Laser Sensor Cable</td>
<td>Provides power to the sensor, and returns sensor readings to Cobra</td>
</tr>
<tr>
<td>Power LED</td>
<td>Indicates power is available to the sensor – illuminates when Scan-X software is active</td>
</tr>
<tr>
<td>Laser LED</td>
<td>Illuminates to indicate laser is taking height measurements</td>
</tr>
<tr>
<td>LCD Screen</td>
<td>Displays a live video image of the part on a 6.8&quot; diagonal TFT-LCD display (only applies to systems equipped with video camera option)</td>
</tr>
<tr>
<td>Camera Assembly</td>
<td>Includes a self-contained B&amp;W CCD video camera and on-axis optical assembly for square-on viewing, and on-axis adjustable LED surface illumination for perfect image (only applies to systems equipped with video camera option)</td>
</tr>
</tbody>
</table>

Never connect or disconnect the laser sensor cable from the top of the sensor while power is applied to Cobra. Doing so can seriously damage the sensor.
Specifications

This table lists the specifications for your Cobra Laser Profile Scanner.

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Cobra 2D</th>
<th>Cobra 3D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth</td>
<td>42.5 cm (16.8&quot;)</td>
<td>61.0 cm (24.0&quot;)</td>
</tr>
<tr>
<td>Width</td>
<td>22.0 cm (8.6&quot;)</td>
<td>51.0 cm (20.0&quot;)</td>
</tr>
<tr>
<td>Height</td>
<td>31.5 cm (12.4&quot;)</td>
<td>39.0 cm (15.4&quot;)</td>
</tr>
<tr>
<td>Weight</td>
<td>10.5 kg (23 lbs)</td>
<td>80 kg (175 lbs)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Travel</th>
<th>Maximum Y axis scan length 50 mm (2.0&quot;)</th>
<th>Maximum X axis scan length 100 mm (4.0&quot;) (only applies to Cobra 3D)</th>
<th>Z axis adjustment range 50 mm (2.0&quot;)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Power and Environment</th>
<th>Power requirements 100-240 VAC, 50/60 Hz, 2.0 Amps</th>
<th>Rated environment • 18-23° C ± 2° C/hr • 30-80% humidity (non-condensing) • vibration &lt;0.002g below 15 Hz</th>
<th>Operating environment 15-30° C</th>
</tr>
</thead>
</table>
Dimensions

Figure 1-4 shows the various dimensions of the Cobra main unit.

* N = Distance from the laser sensor to the target in the middle of the capture range

<table>
<thead>
<tr>
<th>Sensor</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRS-300</td>
<td>17 mm</td>
</tr>
<tr>
<td>DRS-500</td>
<td>17 mm</td>
</tr>
<tr>
<td>DRS-2000</td>
<td>31.5 mm</td>
</tr>
<tr>
<td>DRS-8000</td>
<td>50 mm</td>
</tr>
</tbody>
</table>

Figure 1-4. Cobra Dimensions
Computer Requirements

Scan-X software is compatible with Windows™ 98 Second Edition and Windows 2000. If your purchased the Factory-supplied Computer option, do not make any configuration changes to the computer or load any software prior to consulting your authorized sales representative first; the system configuration has been optimized for use with Cobra.

If you are supplying your own computer it will need to be configured (described later), and must meet the following minimum requirements:

- Pentium III, 500 Mhz processor
- CD-ROM drive
- VGA Card capable of 1024 x 768, 32 BIT color
- Monitor capable of handling 1024 x 768 resolution
- Windows 98 Second Edition or Windows 2000 operating system
- 256 MB RAM (Windows 98); 512 MB RAM (Windows 2000)
- Bi-directional, 1284 compliant parallel port
- Software: DirectX 8.1 or higher; Internet Explorer 6.0 or higher
Section 2

Installation and Setup

This section describes how to install and set up your Cobra, install the Scan-X software, set up the parallel port address, enable the Scan-X 3D mode, and register Scan-X.

System Certification

All Cobra systems are inspected and certified at the factory prior to shipment using NIST-traceable step standards. The systems are certified only for the current mounting position of the sensor mounting pad (Z slide).

In special circumstances, it may be necessary to alter the position of the Z slide to fit a specific application if the slide cannot be moved into the desired position using the Focus knob. For example, a tall part may require more working clearance thereby necessitating a higher mounting position of the Z slide.

Note: If the mounting position of the sensor mounting pad (Z slide) is altered in any way from the factory installed position, your Cobra should be re-certified to ensure system accuracy. See Section 5, Adjusting the Sensor Mounting Pad, for more information on raising or lowering the position of the mounting pad. Consult your local authorized sales representative for more information on field certification of your Cobra system.
Unpacking and Setting Up Cobra 2D

This subsection only applies to Cobra 2D. See the topic, Unpacking and Setting Up Cobra 3D, for information on how to unpack and set up Cobra 3D.

When you receive your Cobra 2D, the shipment will consist of a box that contains the main unit, individually wrapped laser sensor(s), and video camera package (if applicable). The laser sensor(s) is not attached to the main unit.

Note: The shipment will include additional boxes if you also purchased the Factory-supplied Computer option.

The procedure for unpacking Cobra 2D and mounting the laser sensor onto the unit is outlined below.

Tools and Materials Required

To unpack and set up your Cobra 2D system, you will need the following:
- 3 mm hex key (Allen) wrench
- Utility knife
- Machinist square or other quality square tool
- Parallel cable
- Workbench (optional)

Unpacking Procedure

To unpack and set up your Cobra 2D, follow the steps below.

Note: This procedure assumes that if you are supplying your own computer, the computer is already set up and ready to be connected to Cobra.

1. Remove the laser sensor box and the Cobra Laser Profile Scanner from the main shipping carton.
2. Place Cobra on a sturdy work surface.

Note: For optimum performance, we recommend placing Cobra on a granite surface plate.
3. Level Cobra to the work surface.

Use the thumb wheel (located on the back panel) to raise or lower the back of the unit until a machinist square (or other quality square tool) rests squarely on the sensor mounting pad, as shown in Figure 2-1 below.

**Note:** You may need to re-level Cobra once the unit is operational in order to compensate for the work surface or part.

*Figure 2-1. Leveling Cobra 2D*
4. Unpack the DRS laser sensor you want to mount.
   - If you purchased the video camera option, perform the *Mounting the Video Camera and LCD Screen Assemblies* procedure that starts on page 2-6.
   - If you did not purchase the video camera option, continue with Step 5 of this procedure.

5. Mount the laser sensor onto the sensor mounting pad. Use the two positioning pins to align the sensor correctly over the mounting holes, see Figure 2-2 below.

**Note:** Mount the sensor so that the laser sensor connector is on the left side of the sensor as shown in Figure 2-2.

6. Insert the three mounting screws into the mounting holes, and tighten firmly with a 3 mm hex key (Allen) wrench.

7. Connect the laser sensor cable to the top of the sensor as shown in Figure 2-3 on the following page.

---

**Figure 2-2. Installing the Sensor**

Never connect or disconnect the laser sensor cable from the top of the sensor while power is applied to Cobra. Doing so can seriously damage the sensor.
8. If you purchased the Factory-supplied Computer option, unpack and set up the computer and components at this time.

9. Connect a parallel cable from the **PARALLEL PORT** on the Cobra back panel (see Figure 2-3) to the parallel port on the associated computer.

10. Plug the female end of the supplied Cobra power cord into the power cord receptacle on the back panel of Cobra (see Figure 2-3) and connect the male end into a properly configured outlet.

11. If you did **not** purchase the Factory-supplied Computer option, install the Scan-X software onto the associated computer (described later in this section). It is pre-installed on computers purchased from the factory.

This completes the procedure for unpacking and setting up Cobra 2D.

*Figure 2-3. Connecting the Cables*
Mounting the Video Camera and LCD Screen Assemblies

This subsection only applies to Cobra 2D systems equipped with the video camera option. The procedure outlined below assumes that Steps 1 through 4 of the Mounting and Setting Up Cobra 2D procedure have already been completed. If they have not, they must be completed before starting this procedure.

Note: The video camera option can only be used with the DRS-300 and DRS-500 lasers; it cannot be used with the DRS-2000 or DRS-8000 lasers.

Tools and Materials Required

To mount the video camera and LCD screen assemblies onto your Cobra you will need the following:

- 2 mm hex key (Allen) wrench
- 3 mm hex key (Allen) wrench
- 5/32” hex key (Allen) wrench
- Small flat-head screwdriver

Mounting Procedure

To mount the video camera and LCD screen assemblies, follow the steps below.

1. Unpack the video camera accessory package. The package includes the camera and LCD screen assemblies, three partially-threaded screws, and the interconnecting cables.

2. Use a 2 mm hex key (Allen) wrench to remove the four screws securing the camera cover to the camera assembly (see Figure 2-4).

Figure 2-4. Removing the Camera Cover
3. Use a 3 mm hex key (Allen) wrench to remove the two screws shown in Figure 2-5, which partially frees the camera from its mounting plate. Set the screws aside; you will need them later.

The camera is still attached to the mounting plate via the LED power wires (red and black). These two wires are very delicate. Therefore, keep the camera as close as possible to the mounting plate to avoid damaging either wire.

4. Place the DRS-300 or DRS-500 laser sensor on a flat surface, label side up. Then set the camera mounting plate and attached camera on the front of the sensor. Use the two locator pins on the back of the camera mounting plate to correctly position it on the sensor.

**Note:** The video camera option can only be used with the DRS-300 and DRS-500 lasers; it cannot be used with the DRS-2000 or DRS-8000 lasers.
5. Carefully swing the camera assembly to the right (or left) to reveal the lower screw hole in the camera mounting plate. Then insert one of the three partially-threaded screws into the hole and push it through the camera mounting plate and sensor.

The camera is still attached to the mounting plate via the LED power wires (red and black). These two wires are fairly delicate. Therefore, keep the camera close to the mounting plate to avoid damaging either of these wire.

6. With your left (or right) hand, carefully pick up the camera mounting plate and laser sensor, and then position and hold them on the sensor mounting pad. Use the two positioning pins on the sensor mounting pad to align the sensor and camera mounting plate over the mounting holes in the mounting pad. When positioning the components, make sure that the camera mounting plate remains aligned on the sensor.

7. With your free hand, use a 3 mm hex key (Allen) wrench to tighten the partially-threaded screw you inserted into the lower mounting hole (Step 5) and secure the camera mounting plate and sensor to the sensor mounting pad.

Use Figure 2-6 for reference.

![Figure 2-6. Attaching the Camera Mounting Plate and Sensor](image-url)
8. Use a 3 mm hex key (Allen) wrench and the two screws removed in Step 3 to resecure the camera to the camera mounting plate (see Figure 2-7).

9. Insert the other two partially-threaded screws into the upper two screw holes in the camera mounting plate and sensor. Then use a 3 mm hex key (Allen) wrench to tighten the screws firmly (see Figure 2-8).

Figure 2-7. Securing the Camera to the Mounting Plate

Figure 2-8. Tightening the Upper Two Screws
10. Reinstall the camera cover (using the screws removed in Step 2).

11. Screw the LCD screen assembly onto the Cobra handle. Use a 5/32" hex key (Allen) wrench to tighten the mounting screw (see Figure 2-9).

12. Follow the procedure described next to make the necessary cable connections.

**Cable Connections**

After mounting the camera and LCD screen assemblies, follow the steps below to make the necessary cable connections.

1. Locate the Camera and LED Power cable, and then connect J2008 to the LED CTRL port on the Cobra back panel (see Figure 2-10). Use a small flat-head screwdriver to tighten the two screw-locks (one on each side of the connector) firmly.

   ![Figure 2-9. Installing the LCD Screen Assembly](image)

   ![Figure 2-10. Connecting J2008 to the Back Panel](image)
2. Connect J12 to **Camera Power** and J6 to **LED Power** on top of the camera (see Figure 2-11).

![Figure 2-11. Connecting the Camera and LED Power Cable](image)

3. Locate the LCD Screen Power cable. Connect the male end to the Cobra back panel (see Figure 2-12, Part A) and connect the female end to the back of the LCD screen (see Figure 2-12, Part B).

![Figure 2-12. Connecting the LCD Screen Power Cable](image)
4. Locate the Video Signal cable. Connect the female end to the top of the camera (see Figure 2-13, Part A) and connect the male end to the back of the LCD screen (see Figure 2-13, Part B).

5. Connect the laser sensor cable to the top of the sensor as shown in Figure 2-14 on the following page.

6. Use approximately eight cable tie-wraps to route and secure the cables to Cobra as shown in Figure 2-14 on the following page.

Never connect or disconnect the laser sensor cable from the top of the sensor while power is applied to Cobra. Doing so can seriously damage the sensor.
7. If you purchased the Factory-supplied Computer option, unpack and set up the computer and components at this time.

8. Connect a parallel cable from the **PARALLEL PORT** on the Cobra back panel (see Figure 2-14) to the parallel port on the associated computer.

9. Plug the female end of the supplied Cobra power cord into the power cord receptacle on the back panel of Cobra (see Figure 2-14) and connect the male end into a properly configured outlet.

10. If you did **not** purchase the Factory-supplied Computer option, install the Scan-X software onto the associated computer (described later in this section). It is pre-installed on computers purchased from the factory.

**Note:** Before using your Cobra, you may need to focus and align the camera, as described in Appendix B.

This completes the procedure for mounting the video camera and LCD screen assemblies on your Cobra 2D.
Unpacking and Setting Up Cobra 3D

This subsection only applies to Cobra 3D. See the topic, *Unpacking and Setting Up Cobra 2D*, for information on how to unpack and set up Cobra 2D.

When you receive your Cobra 3D, the shipment will consist of a bounded pallet containing the Cobra 3D and any optional accessories. Your Cobra 3D will be fully assembled, so all you need to do is unpack it, set it on a stable support surface, and connect it to the associated computer.

**Tools and Materials Required**

To unpack and set up your Cobra 3D system, you will need the following:

- Fork lift or pallet jack
- Power or manual hoist capable of lifting 80 kg (175 lbs)
- Pair of diagonal cutters
- Parallel cable
- Heavy-duty desk, workbench, table, or other surface (see minimum requirements below)

**Support Surface Requirements**

Cobra 3D can be set up and used on any flat, stable surface. Place Cobra 3D on a heavy-duty desk, workbench, table, or other surface to increase the accuracy and repeatability of your measurements.

The support surface should:

- Not vibrate or shift when you lean on it, or move the stage
- Be able to safely support the full system and parts being scanned - a weight capacity of 90 kg (200 lbs) is recommended
- Have a work area of at least 110 x 110 cm (42 x 42”)

*Installation and Setup*
Unpacking Procedure

Note: Before unpacking Cobra 3D, be sure to review the Support Surface Requirements topic for information about setting Cobra 3D on a stable working surface.

To unpack and set up Cobra 3D, follow the steps below.

Note: This procedure assumes that if you are supplying your own computer, the computer is already set up and ready to be connected to Cobra.

1. Use a fork lift or pallet jack to move the pallet containing Cobra 3D and accessories to the installation site.

The metal bands that bind the shipment are under considerable tension and may recoil unpredictably when cut.

2. Use a pair of diagonal cutters to cut and remove the two metal bands that bind the shipment (see Figure 2-15).

3. Remove the shrink wrap and heavy plastic from around the system boxes.

Figure 2-15. Removing the Packing Material
4. Remove all the boxes, except the Cobra 3D shipping carton, from the pallet and set them aside.
   - The Cobra 3D shipping carton is the largest box on the pallet and is bound by plastic bands (see Figure 2-16).

**Note:** Figure 2-16 illustrates the typical packing arrangement for international orders. For orders shipped within North America, the boxes are usually stacked on top of each other and shipped on a smaller pallet.

The plastic bands that bind the Cobra 3D shipping carton are under considerable tension and may recoil unpredictably when cut.

5. Use a pair of diagonal cutters to cut and remove the two plastic bands that bind the Cobra shipping carton (see Figure 2-16).
6. Remove the top cap from the shipping carton (see Figure 2-16).
7. Remove the top insert and shipping foam from inside the shipping carton.
8. Lift the carton sleeve straight up to remove it from inside the bottom cap (see Figure 2-16).

*Figure 2-16. Unpacking Cobra 3D*
9. Verify that both lifting straps are securely wrapped around the granite base. Then align the ends (loops) of the lifting straps and place them over the hook of a power or manual hoist, as shown in Figure 2-17.

To avoid personal injury, lift the system with a power or manual hoist. If a power or manual hoist is unavailable, use at least two people capable of lifting at least 80 kg (175 lbs) to lift the system manually. Have each person firmly grasp the granite base and lift straight up. When lifting, flex your knees, not your back, to avoid back injury. Avoid pinching your fingers between the granite and work bench when lowering Cobra.

Do not attempt to lift Cobra by the handle on the main unit. This could seriously damage the unit.

10. Position two people next to Cobra — one on either side. Then slowly lift Cobra with the hoist and place it on a sturdy bench capable of bearing its weight.

11. Remove the lifting straps and plastic wrapped around the Cobra main unit.

**Note:** Do not discard the lifting straps. You will need them to relocate Cobra 3D after initial installation.
12. If you purchased the Factory-supplied Computer option, unpack and set up the computer and components at this time.

13. Connect a parallel cable from the **PARALLEL PORT** on the Cobra back panel (see Figure 2-18) to the parallel port on the associated computer.

14. Plug the female end of the supplied Cobra power cord into the power cord receptacle on the Cobra back panel (see Figure 2-18) and connect the male end into a properly configured outlet.

15. If necessary, plug the Motor cable into the **AUX AXIS** port on the Cobra back panel (see Figure 2-18).

16. If you did **not** purchase the Factory-supplied Computer option, install the Scan-X software onto the associated computer (described later in this section). It is pre-installed on computers purchased from the factory.

This completes the Cobra 3D installation procedure.
Installing Scan-X

This subsection describes how to install the Scan-X software on Windows 98 Second Edition and Windows 2000 systems. If you purchased the Factory-supplied Computer option, you can skip this section because Scan-X was installed on your computer at the factory.

**Note:** Before installing Scan-X, make sure your computer meets the minimum requirements outlined in Section 1 of this manual.

The Scan-X installation procedure for Windows 98 Second Edition systems is described next and is followed by the installation procedure for Windows 2000 systems.

### Installing on Windows 98 Second Edition Systems

To install the Scan-X software on a Windows 98 Second Edition system, follow the steps below.

1. Turn on your computer and bring up the Windows desktop.

   **Note:** We strongly recommend closing all Windows programs before installing Scan-X. This ensures that the software installs properly.

2. Insert the Scan-X installation CD-ROM into your system CD drive.

3. Click on **Start**. Then highlight and select **Run**.

   The Run dialog box is displayed.

4. Type `d:\Disk1\Setup.exe` in the command line or click on the **Browse** button to locate the correct file. Then click on the **OK** button.
The system loads the InstallShield® Wizard and displays the Welcome to the InstallShield Wizard for Scan-X dialog box.

5. Read the dialog box message. Then click on the Next button to continue. The system displays the Choose Destination Location dialog box.

6. If you agree with the recommended Destination Folder shown at the bottom of the dialog box, click on the Next button to continue.
   
   If you want a different destination, click on the Browse button and select another folder. Then click on the Next button to continue.
The system displays the Select Program Folder dialog box.

7. If you agree with the recommended **Program Folder** shown in the command line, click on the **Next** button to continue.

   If you want a different folder, type a new folder name or select a folder in the **Existing Folders** list. Then click on the **Next** button to continue.

   The system displays the Start Copying Files dialog box.

8. The system prompts you to verify the current settings.

   To review or change settings, click on the **Back** button.

   If the settings are correct, click on the **Next** button to begin copying files.
The system starts copying files from the CD-ROM, and displays the InstallShield Wizard Complete dialog box when finished.

9. Click on the **Finish** button to complete the Scan-X installation program. Scan-X automatically places an icon on the desktop of your computer.

**Note:** We recommend restarting your computer at this time to ensure that Scan-X installs properly.

**Important:** Before you can use your Cobra system, you must set up the parallel port address (described on page 2-28). For Cobra 3D systems, you must also enable the Scan-X 3D mode (described on page 2-30).
Installing on Windows 2000 Systems

To install the Scan-X software on a Windows 2000 system, follow the steps below.

1. Turn on your computer and bring up the Windows desktop.

   **Note:** We strongly recommend closing all Windows programs before installing Scan-X. This ensures that the software installs properly.

2. Insert the Scan-X installation CD-ROM into your system CD drive.

3. Click on **Start**. Then highlight and select **Run**.

   The Run dialog box is displayed.

   ![Run dialog box](image)

   4. Type `d:` (or the letter of your CD drive) `\Disk1\Setup.exe` in the command line or click on the **Browse** button to locate the correct file. Then click on the **OK** button.

      - If the system displays the following dialog box, click on **OK** and continue with Step 5 of this procedure.

        ![Information dialog box](image)
If the system loads the InstallShield Wizard and displays the Welcome to the InstallShield Wizard for Scan-X dialog box, continue with Step 9 of this procedure.

5. Click on Start. Then highlight and select Run.

The Run dialog box is displayed.

6. Type `c:\ZCSetup.exe` in the command line and click on OK.
The system displays the following dialog box.

7. Select the **Load Driver On Boot** check box and click on **Install**.
8. Reboot your computer and go back to Step 1 of this procedure.
9. Read the dialog box message. Then click on the **Next** button.

The system displays the Choose Destination Location dialog box.

10. If you agree with the recommended **Destination Folder** shown at the bottom of the dialog box, click on the **Next** button to continue.

If you want a different destination, click on the **Browse** button and select a different folder. Then click on the **Next** button to continue.
The system displays the Select Program Folder dialog box.

11. If you agree with the recommended **Program Folder** shown in the command line, click on the **Next** button to continue.

If you want a different folder, type a new folder name or select a folder from the **Existing Folders** list. Then click on the **Next** button to continue.

The system displays the Start Copying Files dialog box.

12. The system prompts you to verify the current settings.

To review or change settings, click on the **Back** button.

If the settings are correct, click on the **Next** button to begin copying files.
The system starts copying files from the CD-ROM, and displays the InstallShield Wizard Complete dialog box when finished.

13. Click on the Finish button to complete the Scan-X installation program.

Scan-X automatically places an icon on the desktop of your computer.

**Note:** We recommend restarting your computer at this time to ensure that Scan-X installs properly.

**Important:** Before you can use your Cobra system, you must set up the parallel port address (described on page 2-28). For Cobra 3D systems, you must also enable the Scan-X 3D mode (described on page 2-30).
Setting the Parallel Port Address and Mode

In order for Scan-X to communicate with Cobra, the parallel port address and mode need to be set properly. In the event that these settings are incorrect, the following error message will be displayed when you launch Scan-X.

![Error Message]

**Note:** If your Cobra came with a factory-supplied computer, you can skip this section (the parallel port on your system was set at the factory).

The parallel port mode needs to be set to ‘Bi-directional’ mode. For on-board parallel ports, this is done by entering the computer system’s BIOS upon boot up and changing the configuration setting from ‘Standard’ to ‘Bi-directional’, which is also commonly referred to as ‘ECP+EPP’. Consult your Management Information System Administrator for assistance in setting the parallel port mode.
The parallel port address setting needs to match the physical port to which the parallel cable is connected. This is done by editing the Scan-X Configuration Settings file, SCANX.INI, located in the following default folder:

C:\Program Files\Scan-X\Config

Assign the port address to the appropriate parallel port being used by typing in either the port number (e.g., 1, 2, 3, 4) or the port address (e.g., &H378). Save the file by selecting **File / Save** before exiting.
Enabling Scan-X 3D Mode

This subsection only applies to users who are using Scan-X on a Cobra 3D system that was purchased without the Factory-supplied Computer option. If your Cobra 3D system was purchased with the Factory-supplied Computer option, you can skip this section because Scan-X 3D mode was enabled at the factory.

To enable Scan-X 3D mode, follow the steps below.

1. Open the SCANX.INI file located in the following default directory:
   C:\Program Files\Scan-X\Config

2. Enter a 2 in the Stages field, see below.

3. Save the file by selecting File / Save before exiting.

```ini
[Hardware]
ScanXX=1
# Units = 0 MM
# Units = 1 UM
# Units = 2 IN
Units=0
# Stages = 1 2D
# Stages = 2 3D
Stages=2
# LEDControl = 0 Hide LED Control
# LEDControl = 1 Show LED Control
LEDControl = 0
# LptPortAddress = Base address for LPT port
LptPortAddress=1

[Laser]
# MaxRange = Specified max range of the laser currently installed
MaxRange=500
# Type Unused
Type=1
```
Registering Scan-X

When you initially start Scan-X, the software displays the Machine Registration dialog box, which prompts you to register the software. You can register Scan-X now or later.

To register Scan-X now, follow the steps below.

1. Insert the supplied Options disk into the floppy drive.
2. Enter the serial number of your Cobra (for example, CB1105) in the Serial Number box.
3. Click on the Register button.

Note: The serial number is located on top of the unit.

To register Scan-X later, simply click on the Demo button to run Scan-X as a demonstration copy, and register at a later time.

Note: Scan-X comes with a 60 day trial period. After the trial period expires, you need to register Scan-X in order to continue using the software.

When you are ready to register Scan-X, follow the steps below.

1. In Scan-X, select Register Software in the Help menu.
   The Machine Registration dialog box is displayed (see above).
2. Insert the supplied Options disk into the floppy drive.
3. Enter the serial number of your Cobra (for example, CB1105) in the Serial Number box.

Note: The serial number is located on top of the unit.

4. Click on the Register button.
This page was left blank intentionally.
This section describes how to power up and shut down your Cobra system, access the Scan-X software and its on-line Help, raise and lower the sensor, perform a scan, and optimize laser settings.

**Powering Up Your System**

After unpacking your Cobra and installing the Scan-X software on the associated computer (if applicable), you are ready to power up your Cobra system.

To do so, follow the steps below.

1. Turn on the computer and monitor.
2. Turn on your Cobra. The power switch is located in the upper-right corner on the Cobra back panel as shown in Figure 3-1.
3. Access Scan-X by using one of the following methods:
   - Double click on the **Scan-X** icon, located on the Windows desktop
   - Left click on the **Scan-X** icon, and then right click and select **Open** from the pop-up menu
   - Click on the **Start** button, and then select **Programs** ⇒ **Scan-X** ⇒ **Scan-X**

Your Cobra system is powered up and ready to use.

**Note:** You can perform a normal system shutdown by exiting Scan-X and Windows, turning off the computer and monitor, and then turning off Cobra.
Screen Layout (2D Mode)

The Scan-X screen in 2D mode is divided into the areas and windows displayed below.
Screen Layout (3D Mode)

The Scan-X screen in 3D mode is divided into the areas and windows displayed below.

Accessing the Scan-X On-Line Help

The on-line Help topics describe the software functions, explain how to use the software, and provide information for specific dialog boxes and fields. To access the Scan-X on-line Help, select Scan-X Help in the Help menu or press F1 on the keyboard.

You can use the Contents list or Index list to find the topics you want to view. (See How to View Help Topics on the following page for more information.)

In addition to the on-line Help topics, you can also view examples of measurements that can be made using Scan-X. Specific parts were measured to create the various profiles and rasters. These illustrations should be used as a guide when making your own measurements. To access the measurement examples, select Measurement Examples in the Help menu.

On-line Help: See the topics, 2D Measurements and 3D Measurements, for more information.
How to View Help Topics

To view a topic from the Contents list, follow the steps below.

1. Access the Scan-X on-line Help, as described on the previous page.
2. Click on the Contents tab.
3. Double-click on the desired topic book. Repeat for other books until you see the desired book, e.g., Windows.
   - The topic book opens, and a list of sub-topics is displayed.
4. Double-click on the topic you want to view, e.g., Sensor Settings Window, or highlight the topic and click on the Display button.
   - The selected topic is then displayed as shown on the following page.

To view a topic from the Index list, follow the steps below.

1. Access the Scan-X on-line Help, as described on the previous page.
2. Click on the Index tab.
3. Type the text that you are searching for, e.g., sensor settings.
   - The software displays the topics that match the text.
4. Double-click on the topic you wish to view, e.g., Sensor Settings Window, or highlight the topic and click on the Display button.
   - The selected topic is then displayed as shown on the following page.

Note: You can also scroll through the Index list until you find the desired topic.
Help Topic Window

When you are viewing a single Help topic, the window is divided into the following two parts:

- The top portion, or banner, contains the topic title and navigation buttons.
- The bottom portion contains the Help text. If it does not fit into one window, use the scroll bar on the right to view the rest of the text. You can jump to any topic that is shown in green simply by clicking on the link.

If you wish to view a Help topic and use the software at the same time (for example, when you wish to follow a step-by-step procedure), select **Keep Help on Top** in the Options menu, and then change the size of the Help window by dragging the corners, and place where you want by dragging from the title bar while holding the left mouse button.
Raising and Lowering the Sensor

The sensor mounting pad (Z axis slide) on your Cobra includes the following two components:

- The knurled **Focus Knob** is located on the right side of the sensor mounting pad, as shown in Figure 3-1, and is used to raise or lower the sensor to focus the sensor on the surface of a part. Twist the Focus knob clockwise to raise the sensor and counter-clockwise to lower it (make sure the Locking knob is not tightened).

- The **Locking Knob** is located on the left side of the sensor mounting pad, as shown in Figure 3-1, and is used to lock the Z axis slide in position when the sensor is at the optimal position. We recommend that you tighten the Locking knob before performing a scan.

**Note:** When you tighten the Locking knob, the sensor cannot be raised or lowered.

**On-line Help:** See the topic, *How to Focus the Sensor*, for more information on focusing the sensor.

*Figure 3-1. Focus Knob and Locking Knob*
How to Perform a Scan: Scanning a Penny

This sub-section includes a tutorial on how to create a profile by scanning a penny. This tutorial is intended to familiarize you with the basic functions of Scan-X and help you become familiar with the Cobra motion controls.

In this tutorial you will:

- Position a penny, focus the laser sensor, and set scan controls
- Scan a penny to create a profile
- Collect height and length measurement results
- Save the measurement results from the laser scan
- View the measurement results from the laser scan

This tutorial is also documented in the Scan-X on-line help. To access this procedure follow the steps below.

1. Access Scan-X, as described earlier.
2. In the Help menu, select Scan-X Help.
3. Click on the Contents tab.
5. Double-click on the topic, Introduction to Scan-X Coach.

- Follow the instructions in the Coach to complete the exercise.
To create a profile by scanning a penny, follow the steps below.

1. Click on the **Laser Home** icon and then click on **Yes** in response to the prompt.

2. If necessary, click on the **Laser Locator** button to turn on the Laser Locator. When turned on, the sensor emits a high intensity laser signal onto the part and makes it easier to see the laser spot.

3. Position a penny under the sensor so that:
   - The Lincoln Memorial side of the penny is up.
   - A small red laser spot is displayed on the surface of the penny, near the end of the Lincoln Memorial that is closest to the Cobra system.

4. Click the **Laser Locator** button to turn off the Laser Locator. This activates the Laser Focus bar.
   - The Laser Focus bar is located on the left side of the Profile View, below the Laser Locator button.

   **Note:** The Laser Locator needs to be turned off before attempting to focus the laser onto the part.

5. Twist the Focus knob to raise or lower the sensor to an approximate focus distance above the penny.

6. Slowly twist the Focus knob to move the sensor in relation to the surface of the penny, and observe the Laser Focus bar.
   - The sensor is focused when the Laser Focus bar is green with a red horizontal bar in the middle of the Laser Focus bar.

**On-line Help:** See the topic, *How to Focus the Sensor*, for more information on focusing the sensor.
7. Click on the **MM** icon or select **Millimeters** in the **Units** menu.

8. Check the **X** and **Y** boxes in the Motion Control window to specify the XY axes (Cobra 3D only).

9. Click on the **Start** button in the Motion Control window to identify the current sensor position as the starting point of the scan.
   - The value in the start position field(s) should be 0.

10. Enter a value of **13** in the end position field (Y end position field for a 3D scan), as shown below. For a 3D scan, also enter a value of **5** in the X end position field.

11. Enter a value of **0.05** in the Step box, see below. For a 3D scan, enter a value of **0.50** in the Step box for both the X and Y axes.

![Profile](image1.png)

   12. Click on the **Measure New Profile** icon to start the laser scan.
   - The profile is displayed as data is collected (see below).
   - The first column in the Lincoln Memorial is displayed as a “bump” in the profile. When the scan is complete, all 12 columns are displayed as “bumps” with some flat areas next to each column (see below).
13. Click on the **Differential** icon or select **Differential** in the **Cursors** menu.

14. In the Output window, select **Height (Avg)** in the first measurement drop-down box.

15. Click and drag the primary cursor boundaries, so that the cursor includes the top of a column, as shown below.

16. Click and drag the reference cursor boundaries, so that the cursor includes a flat area next to the column, as shown below.

   - The height of the column in the primary cursor is displayed in the Output window next to **Height (Avg)**, and should be between 0.06 and 0.09 mm.

17. In the Output window, check the box next to the **Height (Avg)**.

   - The software automatically lists the height results in the Report View window.
18. In the Output window, select **Length** in the second measurement drop-down box.

19. Click and drag the primary cursor boundaries to the start of the first column and the end of the last column in the profile, as shown below.

   - The position of the reference cursor does not have an effect on this measurement.
   - The length of the Lincoln Memorial is displayed in the Output window, next to **Length**, and should be approximately 12.0 mm.

![Profile with Primary and Reference Cursors](image)

20. In the Output window, check the box next to **Length**.

   - The software automatically lists the length results in the Report View window.

21. Click on the **Save** icon or select **Save** in the **File** menu.

   - The Save File dialog box is displayed.

22. Select **.sc6** in the **Save as Type** list.

23. Select the folder where you want to save the file.

24. Enter a filename (for example, Penny_scan).

25. Click on **Save**.

26. Click on the **Report View** tab to display the Report View window.

   - The results of the height and length measurements are listed.
   - If a printer is connected to the system, click on the **Print** button to output the measurement results to the printer.

27. If you performed a 3D scan, click on the **Raster** tab to display the Raster View window.

   - The Raster View is composed of multiple profiles, which provide a top-view, three-dimensional map of the part or feature.

You have successfully completed this tutorial.
Optimizing Laser Settings

When using your Cobra, you may find it necessary to adjust the Maximum Exposure and/or Threshold settings to obtain optimal scan results. These two settings can be manipulated in the Sensor Settings window, which is accessed by clicking on the **Sensor Settings** tab.

### Maximum Exposure

This value is the *maximum* amount of time used to measure each point. Use this control to set the maximum exposure time needed to obtain a valid height reading. The acceptable values for this setting are from 0.000002 to 0.065535 seconds. The default value is 0.005, which provides acceptable results for most surfaces.

**Note:** In most cases, a valid reading can be obtained well within the default maximum exposure setting.

The Maximum Exposure setting has a significant impact on scan velocity and time. As you increase the exposure time, the scan velocity decreases, which increases the time needed to complete the scan. Conversely, when you decrease the exposure time, the scan velocity increases, and the total scan time decreases.
Set the maximum exposure value based on the reflectivity of the part surface.

- For highly reflective part surfaces and/or specular sensors, use shorter maximum exposure values.
- For less reflective part surfaces and/or diffuse sensors, use longer maximum exposure values.
- If you scan a variety of surfaces, longer maximum exposure settings work best, but may increase the total scan time.

**Note:** If data is missing as you scan (data drop outs), increase the maximum exposure. If not, try decreasing the maximum exposure to increase your scan speed when the length of time for a scan is an issue.

---

**Threshold**

This control sets the laser threshold. The threshold value is represented by a red line in the Sensor Settings window. Data below the bar is eliminated from the evaluation and data above the bar is included.

The sensor spot height calculation algorithm disregards pixels with light intensity below the threshold value. Use the threshold value to eliminate the effects of unwanted signals, such as secondary reflections.

The threshold value can be set to any integer value between 10 and 255; the default is 50. Typically, you should set the threshold as low as possible without including secondary spots above the threshold bar in the Sensor Settings window. Settings that are too low can produce unreliable data.

**Note:** The default threshold value (50) works well for most applications and usually does not need to be adjusted.
This page was left blank intentionally.
One unique feature of Cobra is that you can quickly and easily replace one sensor model with another to accommodate your specific application. This section provides information on the different DRS models available and how to swap one sensor for another.

**Note:** The procedure for swapping laser sensors varies, depending on the configuration of your Cobra. The procedure for changing sensors on Cobra systems equipped with the video camera option starts on the following page and the procedure for changing sensors on Cobra systems not equipped with the video camera option starts on page 4-8. Be sure to follow the procedure that applies to your system.

### DRS Models

There are four different sensor models available for use with Cobra. This table lists each model and its specifications.

<table>
<thead>
<tr>
<th>Model</th>
<th>Sensor Type</th>
<th>Capture Range</th>
<th>Z Accuracy (within capture range)</th>
<th>Dynamic Resolution</th>
<th>Spot Size</th>
<th>Standoff*</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRS-300</td>
<td>Specular</td>
<td>300 µm</td>
<td>1.0 µm</td>
<td>0.125 µm</td>
<td>7-12 µm</td>
<td>17 mm</td>
</tr>
<tr>
<td>DRS-500</td>
<td>Specular</td>
<td>500 µm</td>
<td>1.0 µm</td>
<td>0.125 µm</td>
<td>16-23 µm</td>
<td>17 mm</td>
</tr>
<tr>
<td>DRS-2000</td>
<td>Diffuse</td>
<td>2000 µm</td>
<td>10 µm</td>
<td>1.0 µm</td>
<td>32-48 µm</td>
<td>31.5 mm</td>
</tr>
<tr>
<td>DRS-8000</td>
<td>Diffuse</td>
<td>8000 µm</td>
<td>40 µm</td>
<td>4.0 µm</td>
<td>60-85 µm</td>
<td>50 mm</td>
</tr>
</tbody>
</table>

* Standoff is the distance in Z from the lowest point on the sensor to the middle of the capture range.
Swapping Sensors on Systems Equipped with the Video Camera Option

This subsection only applies to Cobra systems equipped with the video camera option, and describes how to remove the video camera assembly and sensor so that you can swap sensors.

**Note:** The video camera option can only be used with DRS-300 and DRS-500 lasers; it cannot be used with the DRS-2000 or DRS-8000 lasers.

Removing the Video Camera Assembly and Sensor

To remove the video camera assembly and sensor, follow the steps below. You will need 2 mm and 3 mm hex key (Allen) wrenches.

1. Power down your Cobra.

   Never connect or disconnect the laser sensor cable from the sensor while power is applied to Cobra. Doing so could seriously damage the sensor.

2. Disconnect the laser sensor cable from the top of the sensor.

3. Use a 2 mm hex key (Allen) wrench to remove the four screws securing the camera cover to the video camera assembly (see Figure 2-4 on page 2-6).
4. Use a 3 mm hex key (Allen) wrench to remove the two screws securing the video camera to the camera mounting plate (see Figure 4-1).

The camera is still attached to the mounting plate via the LED power wires (red and black). These two wires are fairly delicate. Therefore, keep the camera close to the mounting plate to avoid damaging either of these two wire.

![Figure 4-1. Removing the Camera Mounting Screws](image)
5. Carefully swing the video camera to the right (or left) to reveal the lower sensor mounting screw. Then use a 3 mm hex key (Allen) wrench to remove the screw. See Figure 4-2.

6. Hold the camera assembly, mounting plate, and sensor as you remove the other two sensor mounting screws (see Figure 4-3). Use a 3 mm hex key (Allen) wrench.

Figure 4-2. Removing the Lower Mounting Screw

Figure 4-3. Removing the Upper Two Mounting Screws
7. Remove the camera assembly, camera mounting plate, and sensor, and set down gently.

8. When ready, reinstall the video camera assembly, mounting plate, and replacement sensor, as described in the next subsection.

**Note:** The video camera option can only be used with the DRS-300 and DRS-500 lasers; it cannot be used with the DRS-2000 or DRS-8000 lasers.

This completes the procedure for removing the video camera assembly and sensor.

### Mounting the Video Camera Assembly and Sensor

To mounting the video camera assembly and replacement sensor, follow the steps below. You will need 2 mm and 3 mm hex key (Allen) wrenches.

1. Place the DRS-300 or DRS-500 laser sensor on a flat surface, label side up. Then set the camera mounting plate and attached camera on the front of the sensor. Use the two locator pins on the back of the camera mounting plate to correctly position it on the sensor.

**Note:** The video camera option can only be used with the DRS-300 and DRS-500 lasers; it cannot be used with the DRS-2000 or DRS-8000 lasers.

2. Refer to Figure 4-4 on the following page and perform the following steps:
   a. Carefully swing the camera assembly to the right (or left) to reveal the lower screw hole in the camera mounting plate. Then insert one of the three partially-threaded screws into the hole and push it through the camera mounting plate and sensor.

   The camera is still attached to the mounting plate via the LED power wires (red and black). These two wires are fairly delicate. Therefore, keep the camera close to the mounting plate to avoid damaging either of these two wire

   b. With your left (or right) hand, carefully pick up the camera mounting plate and laser sensor, and then position and hold them on the sensor mounting pad. Use the two positioning pins on the sensor mounting pad to align the sensor and camera mounting plate over the mounting holes in the mounting pad. When positioning the components, make sure that the camera mounting plate remains aligned on the sensor.

   c. With your free hand, use a 3 mm hex key (Allen) wrench to tighten the partially-threaded screw you inserted into the lower mounting hole (Step 2a) and secure the camera mounting plate and sensor to the sensor mounting pad.
3. Use a 3 mm hex key (Allen) wrench and the two screws removed in Step 4 of the previous procedure to resecure the camera to the camera mounting plate (see Figure 4-5).

Figure 4-4. Installing the Camera Mounting Plate and Sensor

Figure 4-5. Securing the Camera to the Mounting Plate
4. Insert the other two partially-threaded screws into the upper two screw holes in the camera mounting plate and sensor. Then use a 3 mm hex key (Allen) wrench to tighten the screws firmly (see Figure 4-6).

![Figure 4-6. Installing the Upper Two Screws](image)

Never connect or disconnect the laser sensor cable from the sensor while power is applied to Cobra. Doing so could seriously damage the sensor.

5. Connect the laser sensor cable to the top of the sensor.

6. Check the camera focus and alignment, as described in Appendix B.

This completes the procedure for mounting the video camera assembly and replacement sensor.
Swapping Sensors on Systems Not Equipped with the Video Camera Option

This subsection only applies to Cobra systems not equipped with the video camera option, and describes how to remove and replace sensors.

Removing a Sensor

To remove the sensor currently installed on your Cobra system, follow the steps below. You will need a 3 mm hex key (Allen) wrench.

1. Power down your Cobra system.

   Never connect or disconnect the laser sensor cable from the sensor while power is applied to Cobra. Doing so could seriously damage the sensor.

2. Disconnect the laser sensor cable from the top of the sensor, see Figure 4-7.

   Hold onto the sensor as you remove the three sensor mounting screws. If the sensor is not supported, it can fall off the sensor mounting pad and be damaged.

3. Hold the sensor with one hand and remove the three M4 socket-head cap mounting screws with your free hand. Use a 3 mm hex key (Allen) wrench.

Figure 4-7. Removing the Laser Sensor
4. Remove the sensor from the sensor mounting pad, by pulling it away from the Cobra.

5. When you are ready, install the replacement sensor, as described in the next procedure.

This completes the procedure for removing the laser sensor.

Mounting a Sensor

To mount a sensor onto your Cobra system, follow the steps below. You will need a 3 mm hex key (Allen) wrench.

1. Power down your Cobra system.

2. Mount the laser sensor onto the sensor mounting pad. Use the two positioning pins to align the sensor correctly over the mounting holes, see Figure 4-8 below.

**Note:** Mount the sensor so that the laser sensor connector is on the left side of the sensor as shown in Figure 4-8.

![Figure 4-8. Mounting a Sensor](image-url)
3. Insert the three mounting screws into the mounting holes, and tighten with a 3 mm hex key (Allen) wrench

Never connect or disconnect the laser sensor cable from the sensor while power is applied to Cobra. Doing so could seriously damage the sensor.

4. Connect the sensor cable to the top of the sensor, see Figure 4-8 on the previous page.

This completes the procedure for mounting a sensor.
This section describes how to adjust the rotational and vertical mounting position of the sensor mounting pad (Z slide). It may be necessary to adjust the rotational mounting position of the mounting pad in the event of a certification failure and any time the vertical position of the mounting pad is altered. The vertical position of the mounting pad may need to be altered to fit a specific application in the event that the slide cannot be moved into the desired position using the Focus knob.

**Note:** If the mounting position of the sensor mounting pad (Z slide) is altered in any way from the factory installed position, your Cobra should be re-certified to ensure system accuracy. See the topic, *System Certification*, in Section 2 for more information. Consult your local authorized sales representative for more information on field certification of your Cobra system.

### Rotational Alignment

The rotational alignment procedure aligns the sensor mounting pad so it is square to the working surface. Before performing this procedure, contact your local authorized sales representative to determine whether or not alignment is necessary. This procedure requires that Cobra is installed and level.

**Note:** The sensor mounting pad was pre-aligned and your system was certified at the factory (see the topic, *System Certification*, in Section 2 for more information). The following procedure will disrupt the alignment and void the certification of your Cobra system.

To rotationally align the sensor mounting pad follow the steps below.

1. Remove the DRS laser sensor, as described in Section 4.
2. Loosen the Locking knob (see Figure 5-1).
3. Twist the Focus knob to raise or lower the sensor mounting pad along the Z axis slide so that the two M4 socket-head cap screws used to secure the mounting pad to the system are visible through the access holes in the mounting pad (see Figure 5-1).

![Figure 5-1. Sensor Mounting Pad Screws](image)

4. Place a machinist square or other quality square tool on the work surface, parallel to the X axis, and observe whether or not both of the positioning pins on the sensor mounting pad make contact with the square tool, as shown in Figure 5-2 on the following page.
   - If both pins touch the square tool, go to Step 9.
   - If either of the two pins **do not** touch the square tool, go to Step 5.

---

5-2 Adjusting the Sensor Mounting Pad
5. Use a 3 mm hex key (Allen) wrench to loosen (do not remove) the two M4 socket-head cap screws used to secure the sensor mounting pad to the Cobra main unit (see Figure 5-1 on the previous page).

6. Gently rotate the sensor mounting pad until both positioning pins make contact with the square tool.

7. Firmly retighten the two screws loosened in Step 5.

8. Verify that both positioning pins still make contact with the square tool after tightening the sensor mounting pad screws.
   - If both pins touch the square tool, go to Step 9.
   - If either of the two pins do not touch the square tool, go back to Step 5.

9. Reinstall the laser sensor, as described in Section 4.

This completes the procedure for rotationally aligning the sensor mounting pad.
In order to satisfy specific application requirements, you may find it necessary to adjust the vertical position of the sensor mounting pad. You can move the sensor mounting pad 25.4 mm (1.0") with this procedure.

To adjust the vertical position of the sensor mounting pad, follow the steps below.

**Note:** The sensor mounting pad was pre-aligned and your system was certified at the factory (see the topic, *System Certification* in Section 2 for more information). The following procedure will disrupt the alignment and void the certification of your Cobra system.

1. Remove the DRS laser sensor, as described in Section 4.
2. Loosen the Locking knob (see Figure 5-3).
3. Twist the Focus knob to raise or lower the sensor mounting pad along the Z axis slide so that the two M4 socket-head cap screws used to secure the mounting pad to the system are visible through the access holes in the mounting pad (see Figure 5-3).
4. Use a 3 mm hex key (Allen) wrench to remove the two M4 socket-head cap screws used to secure the sensor mounting pad to the Cobra main unit (see Figure 5-3).

![Figure 5-3. Sensor Mounting Pad Screws](image)
5. Raise or lower the sensor mounting pad to the desired position.

6. Verify that at least one pair of access holes in the sensor mounting pad is aligned with a pair of mounting screw holes in the Y axis arm on Cobra. Adjust the position of the mounting pad if necessary.

7. Screw the two M4 socket-head cap screws removed in Step 4 into the sensor mounting pad access holes, and tighten. Use a 3 mm hex key (Allen) wrench.

8. Perform Steps 4 through 8 of the Rotational Alignment procedure described previously in this section to verify the rotational alignment of the sensor mounting pad.

9. Reinstall the DRS laser sensor, as described in Section 4.

This completes the procedure for adjusting the vertical position of the sensor mounting pad.
This page was left blank intentionally.
Section 6

Troubleshooting

This section provides information that will help you troubleshoot and resolve system problems. If the solutions do not resolve your system problem(s), contact your local authorized sales representative for further assistance.

**Note:** Refer to the Scan-X Reference Guide (P/N 790338) for troubleshooting information related to the Scan-X software.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cobra does not power up</td>
<td>Main power is off</td>
<td>Turn on the main power</td>
</tr>
<tr>
<td></td>
<td>Cobra power cord is not connected to Cobra</td>
<td>Plug Cobra power cord into the power cord receptacle on the Cobra back panel</td>
</tr>
<tr>
<td></td>
<td>Cobra power cord is not connected to the main power source</td>
<td>Connect the Cobra power cord to the main power source</td>
</tr>
<tr>
<td></td>
<td>Faulty wall outlet</td>
<td>Use different wall outlet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Repair current wall outlet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reset circuit breaker</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make sure system is plugged into an outlet that meets the system power requirements</td>
</tr>
<tr>
<td></td>
<td>Faulty Cobra power cord</td>
<td>Swap suspected faulty power cord for known good one; replace if necessary</td>
</tr>
<tr>
<td>Scan-X does not detect Cobra</td>
<td>Parallel port is not set to 'bi-directional'</td>
<td>Set the parallel port to 'bi-directional'</td>
</tr>
<tr>
<td></td>
<td>Parallel port designation is not set</td>
<td>Specify the parallel port being used by Cobra, as described in Section 2</td>
</tr>
<tr>
<td></td>
<td>Faulty parallel cable</td>
<td>Swap suspected faulty cable for known good one; replace if necessary</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Possible Solution</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Computer monitor does not turn on</td>
<td>Main power is off</td>
<td>Turn on the main power</td>
</tr>
<tr>
<td></td>
<td>Monitor is not connected to the main power source</td>
<td>Connect monitor to the main power source</td>
</tr>
<tr>
<td></td>
<td>Faulty monitor</td>
<td>Swap suspected faulty monitor for known good one; replace monitor if necessary</td>
</tr>
<tr>
<td>Computer monitor turns on, but the screen is blank</td>
<td>Monitor is not connected to the computer</td>
<td>Connect the monitor to the computer</td>
</tr>
<tr>
<td></td>
<td>Faulty monitor</td>
<td>Check if monitor works correctly on another system; replace if necessary</td>
</tr>
<tr>
<td>LCD screen does not turn on when Cobra is powered up</td>
<td>LCD Screen Power cable is disconnected</td>
<td>Verify that the LCD Screen Power cable is connected to the back of Cobra and the top of the camera (see Figure 2-12)</td>
</tr>
<tr>
<td></td>
<td>Faulty LCD screen</td>
<td>Swap suspected faulty LCD screen for known good one; replace LCD screen if necessary</td>
</tr>
<tr>
<td>LCD screen turns on, but screen is blank</td>
<td>LCD screen is not connected to camera</td>
<td>Verify that Video Signal cable is connected to the top of the camera and back of the LCD screen (see Figure 2-13)</td>
</tr>
<tr>
<td></td>
<td>Faulty LCD screen</td>
<td>Swap suspected faulty LCD screen for known good one; replace LCD screen if necessary</td>
</tr>
<tr>
<td>Keyboard is not functional</td>
<td>Faulty connection between keyboard and computer</td>
<td>Check connection between keyboard and computer</td>
</tr>
<tr>
<td></td>
<td>Faulty keyboard</td>
<td>Swap known good keyboard for suspected faulty one; replace if necessary</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Possible Solution</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sensor gives inaccurate data</td>
<td>Inappropriate step size</td>
<td>Adjust the step size</td>
</tr>
<tr>
<td></td>
<td>Dirty lenses</td>
<td>Check lenses for dirt; clean if necessary</td>
</tr>
<tr>
<td></td>
<td>Inaccurate sensor model and serial numbers</td>
<td>Check the model and serial number in the Sensor Information box (in the Sensor Settings window) to see if they match the sensor on your system; adjust if necessary</td>
</tr>
<tr>
<td>Unable to obtain readings</td>
<td>Loose laser sensor cable connection</td>
<td>Tighten connection</td>
</tr>
<tr>
<td></td>
<td>Dirty sensor lenses</td>
<td>Check lenses for dirt; clean if necessary</td>
</tr>
<tr>
<td></td>
<td>Faulty sensor</td>
<td>Swap suspected faulty sensor for known good one; replace if necessary</td>
</tr>
<tr>
<td>Sensor does not turn on and/or the laser indicator does not light</td>
<td>Loose laser sensor cable connection</td>
<td>Tighten connection</td>
</tr>
<tr>
<td></td>
<td>Computer power is off</td>
<td>Power up computer</td>
</tr>
<tr>
<td></td>
<td>Cobra power is off</td>
<td>Power up Cobra</td>
</tr>
<tr>
<td>Sensor will not collect data</td>
<td>Sensor is not focused</td>
<td>Focus sensor</td>
</tr>
<tr>
<td></td>
<td>Loose laser sensor cable connection</td>
<td>Tighten connection</td>
</tr>
<tr>
<td>Sensor arm will not move</td>
<td>Arm has reached its end of travel limit</td>
<td>Move the arm in the opposite direction</td>
</tr>
<tr>
<td></td>
<td>Cobra power is off</td>
<td>Power up Cobra</td>
</tr>
</tbody>
</table>
This page was left blank intentionally.
Setting the Display Properties

This appendix describes how to adjust the display settings on your system in order to view laser scans in “real-time.”

When you perform a laser scan in Scan-X, the data points are plotted in the Profile View as the sensor moves over the part and takes height measurements. In other words, as the sensor moves across the part, the profile of the surface appears in the Profile View at the same rate the sensor is moving. This is referred to as seeing the scan in “real-time.”

On-line Help: See the topic, *How to Scan a Part.*

If you perform a laser scan, and are unable to see the scan in “real-time,” you may need to reduce one of the following display properties:

- Number of displayed colors
- Hardware Acceleration

**Note:** You only need to adjust the display properties if you are unable to see a laser scan in “real-time.” Do not make any adjustments if the data is displayed in the Profile View at the same rate the sensor is moving.

**Note:** Try reducing the number of displayed colors first. If you still cannot see the scan in “real-time,” try reducing the hardware acceleration setting.
Reducing the Number of Displayed Colors

To reduce the number of displayed colors, follow the steps below.

1. Close all programs. The Windows desktop should now be displayed.
2. Right-click on the Windows desktop and select **Properties** in the pop-up menu to display the Display Properties window.

**Note:** Alternately, you can select Settings / Control Panel in the Windows Start menu and then double-click on Display in the Control Panel window to display the Display Properties window.

3. Click on the **Settings** tab. Something similar to the following is displayed.

4. In the **Colors** drop-down box, select **256 Colors**.
5. Click on **OK**.
6. Restart your computer.
7. Access Scan-X and perform a laser scan.

**On-line Help:** See the topic *How to Scan a Part* for more information.

**Note:** If you are still unable to see the scan in “real-time,” try reducing the hardware acceleration setting, as well (described on the following page).
Reducing the Hardware Acceleration

To reduce the hardware acceleration setting, follow the steps below.

1. Select **Settings / Control Panel** in the **Windows Start** menu.
2. Highlight and select **Display**.
3. Click on the **Settings** tab. The Display Properties window is displayed (see image on the previous page).
4. Click on the **Advanced** button.
5. Click on the **Performance** tab (Windows 98 Second Edition) or the **Troubleshooting** tab (Windows 2000).
6. Reduce the hardware acceleration by moving the **Hardware acceleration** slider to the left, one setting.
7. Click on **OK**.
8. Restart your computer.

**On-line Help:** See the topic, *How to Scan a Part*, for more information.

If you are still unable to see the scan in “real-time” repeat the above procedure until one of the following conditions is met:

- You are able to see the laser scan in “real-time”
- You moved the Hardware acceleration slider all the way to the left, as shown here

**Note:** If you have reduced the number of displayed colors and the hardware acceleration, but still are unable to see the scan in “real-time,” contact your local authorized sales representative for further assistance.
This page was left blank intentionally.
Appendix B

Focusing and Aligning the Camera

This appendix only applies to Cobra systems equipped with the video camera option, and describes how to focus and align the camera.

Focusing the Camera

To focus the camera, follow the steps below. You will need a 2 mm hex key (Allen) wrench.
1. Power up your Cobra system and access Scan-X.
2. Use the Focus Indicator in Scan-X to focus the sensor over the surface of a part. Observe the image of the part on the LCD screen.

On-line Help: See the topic, How to Focus the Sensor, for more information.

- If the image is sharp and in focus, stop here. You do not need to perform the rest of this procedure.
- If the image is not sharp and not in focus, continue with Step 3 of this procedure.

3. Use the Locking knob to lock the Z axis slide and sensor in position, as described in Section 3.
4. Use a 2 mm hex key (Allen) wrench to remove the four screws securing the camera cover to the camera assembly (see Figure 2-4 on page 2-6).
5. Turn the camera collar in a counter-clockwise direction, and loosen it completely (see Figure B-1). The camera is now free to move up and down.

![Figure B-1. Focusing the Camera](image)

6. Manually, adjust the vertical position of the camera until the image on the LCD screen is sharp and in focus. Then, without moving the camera, retighten the camera collar firmly.

**Important:** After tightening the camera collar, verify that the image on the LCD screen is still in focus. If it is not, repeat Steps 5 and 6 until the image remains in focus.

7. Reinstall the camera cover.

This completes the procedure for focusing the video camera on your Cobra system.
Aligning the Camera to the DRS Laser Sensor

To align the video camera on your Cobra system to the DRS laser sensor, follow the steps below. You will need a 2 mm hex key (Allen) wrench.

1. Power up your Cobra system and access Scan-X.
2. Focus the sensor over the surface of a part, and observe the laser spot on the LCD display.

On-line Help: See the topic, *How to Focus the Sensor*, for more information.

- If the laser spot appears centered in the LCD display, **stop here**. You do not need to perform the rest of this procedure.
- If the laser spot does not appear centered in the LCD display, **continue** with Step 3 of this procedure.

3. Use a 2 mm hex key (Allen) wrench to remove the four screws securing the camera cover to the camera assembly (see Figure 2-4 on page 2-6).

4. Align the camera by moving it slightly, as described below, while observing the position of the laser spot on the LCD screen. Continue adjusting the horizontal and/or vertical adjustment screws until the laser spot appears centered in the display. Use a 2 mm hex key (Allen) to adjust the screws.

- To move the laser spot to the right, tighten the horizontal adjustment screw (see Figure B-2 on the following page)
- To move the laser spot to the left, loosen the horizontal adjustment screw (see Figure B-2 on the following page)
- To move the laser spot up, loosen the vertical adjustment screw (see Figure B-2 on the following page)
- To move the laser spot down, tighten the vertical adjustment screw (see Figure B-2 on the following page)
5. Reinstall the camera cover.

This completes the procedure for aligning the video camera on your Cobra system to the DRS laser sensor.
A

Accessing Scan-X on-line help, 3-3
Adjusting the mounting pad, 5-1
Alignment
  Camera, B-3
  Rotational, 5-1

C

Camera
  Alignment, B-3
  Focusing, B-1
Camera assembly, 1-5
Certification, 2-1
Cobra, description of, 1-1
Components, 1-2
  Cobra 2D, 1-2
  Cobra 3D, 1-3
  Cobra with video camera, 1-4
Computer requirements, 1-8

D

Dimensions, 1-6, 1-7
Display properties, A-1
  Reducing the hardware acceleration, A-3
  Reducing the number of colors, A-2
Document
  Conventions, iii
  Organization, i

DRS models, 4-1
  DRS-2000, 4-1
  DRS-300, 4-1
  DRS-500, 4-1
  DRS-8000, 4-1

E

Electrical safety, vii
Enabling Scan-X 3D mode, 2-30
Explosive atmosphere, viii

F

Focus knob, 1-4, 3-6
Focusing the camera, B-1

H

Help topic window, 3-5
How to
  Optimize laser settings, 3-12
  Perform a scan, 3-7
  Raise and lower the sensor, 3-6
  View help topics, 3-4
I

Installation
  Cobra 2D, 2-2
  Cobra 3D, 2-14
  Scan-X, 2-19
    Windows 2000, 2-23
    Windows 98, 2-19
  Sensor, 2-2
  Video camera and LCD assemblies, 2-6
Installation and setup, 2-1
Installing a sensor, 4-9
Installing the video camera, 4-5
Intended audience, ii

L

Laser
  Safety, v
  Safety markings, vi
Laser LED, 1-5
Laser sensor cable, 1-5
LCD screen, 1-5
Locking knob, 1-4, 3-6
Lowering the sensor, 3-6

M

Maximum exposure, 3-12
Medical, viii
More laser safety information, vi
Mounting pad, 1-4, 5-1

N

Nuclear, viii
S
Safety
   Accessories, viii
   Electrical, vii
   Laser, v
   Liquids, vii
   Power and grounding, vii
   Power cord, vii
   Servicing, vii
   Unsafe operating environments, viii
Safety markings, laser, vi
Scan-X
   Enabling 3D mode, 2-30
   Icon, 3-1
   Installation, 2-19
      Windows 2000, 2-23
      Windows 98, 2-19
   On-line help, 3-3
   Registration, 2-31
   Screen layout (2D mode), 3-2
   Screen layout (3D mode), 3-3
      Tutorial, 3-7
Screen layout
   2D mode, 3-2
   3D mode, 3-3
Setting the parallel port address and mode, 2-28
Settings, 3-12
   Maximum exposure, 3-12
      Threshold, 3-13
Special symbols, iv
Specifications, 1-6
Suitable surface, 2-14
System, power up, 3-1
System certification, 2-1

T
Threshold, 3-13
Thumb wheel, 1-4
Troubleshooting, 6-1

V
Vertical adjustment, 5-4

W
Windows
   2000, 2-23
   98 Second Edition, 2-19

X
X axis scan length, 1-6

Y
Y axis scan length, 1-6

Z
Z axis adjustment range, 1-6
This document was produced by the Marketing Communications Department of Quality Vision International, Inc. 850 Hudson Ave., Rochester, New York 14621-4896 USA. Telephone: 585-544-0450. FAX: 585-544-0131. E-mail: webmaster@qvii.com.

The information contained herein is based on the experience and knowledge relating to the subject matter gained by QVI prior to publication. No patent license is granted by this information. QVI RESERVES THE RIGHT TO CHANGE THIS INFORMATION WITHOUT NOTICE AND MAKES NO WARRANTY, EXPRESS OR IMPLIED, WITH RESPECT TO THIS INFORMATION. QVI shall not be liable for any loss or damage, including consequential or special damages, resulting from the use of this information, even if loss or damage is caused by negligence or other fault on the part of QVI.

Caution

This equipment generates, uses, and can radiate radio frequency energy, and if not installed and used in accordance with this documentation, may interfere with radio communications. Operating this equipment in a residential area may cause unacceptable interference to radio and TV reception, requiring the operator to take whatever steps are necessary to correct the interference.

Due to the nature of this material, a number of hardware and software products may be mentioned by name. In most, if not all, cases these product names are claimed as trademarks by the companies that manufacture the products. It is not our intent to claim these names or trademarks as our own.

© 2004 Quality Vision International, Inc. All rights reserved. Printed in USA. Original instructions.

No part of this document may be reproduced or disclosed in any form or for any purpose, other than personal use, without the written permission of Quality Vision International, Inc.